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1

1

Getting Started

Your eMac has been designed so that you can set it up
quickly and start using it right away. If you have never
used an eMac or are new to Macintosh computers, read
this section for instructions on getting started.
If you are an experienced user, you may already know enough to get started. Be sure to
look over the information in Chapter 2, “Getting to Know Your eMac,” to find out about
the new features of this eMac.

Telephone cord

Keyboard
AC cord

Mouse
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Setting Up Your eMac
1 Plug the power cord firmly into the power socket and plug the other end into
a grounded outlet or power strip. See inside the optical drive door panel for voltage
requirements.
2 To enable Internet connectivity, connect your computer’s Ethernet port to an Ethernet
network or to your DSL or cable modem using an Ethernet cable. Or connect your
computer’s modem port (included on some models) to a telephone line using the
included phone cord.

W Modem port
Ethernet port

Telephone cord
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3 Connect the keyboard cable to one of the USB ports ( ) on the computer. Plug the
mouse cable into a USB port on the keyboard.

4 Turn on your computer by pressing the Power button (®) on the side of the computer.

® Power button

Chapter 1 Getting Started
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Adjusting Your Display
To adjust the settings for your display, choose Apple (K) > System Preferences (click the
Apple menu and choose System Preferences) and click Displays.
To increase display contrast, press the F15 key on your keyboard. To decrease contrast,
press F14.

Where to Go From Here
You’ve done everything you need to get your eMac up and running. The first time you
turn on your computer, the Setup Assistant takes you through the process of
configuring your computer and setting it up for the Internet. Internet access usually
requires an account with an Internet service provider (ISP). Fees may apply.
• If you don’t already have an Internet account, the assistant can set you up with one.
• If you already have an Internet account, see Appendix C, “Connecting to the
Internet,” on page 61 for information you’ll need to enter.
If you would like additional information, see the following:

8

To learn about...

See...

Shutting down your computer
or putting it to sleep

“What to Do When You Have Finished Using Your eMac” on page 9.

What you can do with the
hardware and software features
of your eMac

Chapter 2, “Getting to Know Your eMac.”

The additional information
available in the onscreen help

“Getting Answers to Your Questions Using Mac OS Help” on
page 22.

Using a specific feature of your
eMac, or connecting a digital
device, such as an iPod

Chapter 3, “Using Your Computer.”

Installing memory or an AirPort
Extreme Card

Chapter 4, “Enhancing Your Computer.”

What to do if you have a
problem with your eMac

Chapter 5, “Troubleshooting.”

Chapter 1 Getting Started
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What to Do When You Have Finished Using Your eMac
When you have finished working with your eMac, you have two options.

Put Your eMac to Sleep
If you will be away from your eMac for less than a few days, put the computer to sleep.
When the computer is in sleep, its screen is dark and a small white light pulsates to the
right of the optical drive. You can quickly wake it, which takes much less time than the
startup process.
To put the computer to sleep quickly, do one of the following:
• Choose Apple (K) > Sleep.
• Press the Power button.

To wake the computer, press any key on the keyboard.

Shut Down Your eMac
If you will not use your eMac for more than a few days, shut it down.
• Choose Apple (K) > Shut Down.

Warning: Shut down your eMac before moving it. Moving your computer while the
hard disk is spinning can damage the hard disk, causing loss of data or the inability to
start up from the hard disk.

Chapter 1 Getting Started
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2

Getting to Know Your eMac

2

This chapter gives you some basic information you’ll
need to know about your eMac.
Read on for an overview of the different parts of your computer and Mac OS X, and
summary information on common tasks such as customizing the way your desktop
looks, connecting to a printer, playing a CD, connecting a digital camera, using the
Internet, getting answers when you need help, and more.

Using the Applications That Came With Your eMac
Your eMac comes with several fun, useful, easy-to-use software applications that let
you do things like transfer your music from your CD collection to your computer and
organize the songs, easily create new music on your computer, send email, browse the
web, chat with friends, edit home movies, organize your schedule, write letters and
create other documents, and much more.
For more information about these applications, see the Welcome to Panther booklet
that came with your eMac. Or, simply open any application and choose the
application’s help from the Help menu (for example, open iTunes and choose
Help > iTunes Help).

For the Latest Information
Because Apple frequently releases new versions and updates to its system software,
images shown in this book may be slightly different from what you see on your screen.
The Apple website, at www.apple.com, links you to the latest Apple news, free
downloads, and online catalogs of software and hardware for your eMac.
You can also find the manuals for many Apple products and technical support
for all of Apple’s products on the AppleCare Service and Support website at
www.apple.com/support.

11
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eMac – Front View
Microphone

AirPort Extreme
Card slot (inside)

Optical disc drive

Power indicator light

- Volume controls

Stereo speakers

Media Eject key

USB ports

Apple Keyboard
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Apple Mouse
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Microphone
Record sounds directly on your eMac or talk with friends live over the Internet using the included
iChat AV application.
Optical disc drive
Your computer has a CD-ROM drive, a DVD-ROM/CD-RW Combo drive, or a SuperDrive. Each drive can
read CD-ROM discs, photo CDs, standard audio discs, and other kinds of media. Both the Combo drive
and SuperDrive can also read DVD discs and DVD movies, and write music, documents, and other
digital files to CD-R and CD-RW discs. The SuperDrive can also write to blank DVD-R discs using the
Finder or iDVD. To open the drive, press the Media Eject ( ) key on your Apple Keyboard.
Stereo speakers
Listen to music, movies, games, and multimedia.
Two USB (Universal Serial Bus) 1.1 ports (on keyboard)
Connect low-power USB 1.1 devices to your eMac’s keyboard, such as mice, digital cameras, and
joysticks. Connect your Apple Mouse to one of the keyboard USB ports. (There are also three highspeed USB 2.0 ports on the side of your computer.)
AirPort Extreme Card slot
An AirPort Extreme Card in your computer allows you to connect to a wireless network. Your eMac
may have come with an AirPort Extreme Card already installed. If not, you can purchase an AirPort
Extreme Card and install it yourself. See “Installing an AirPort Extreme Card” on page 41.
Bluetooth module (inside)
With the Bluetooth module (optional) you can connect wirelessly to devices, such as Bluetooth
enabled mobile phones, digital cameras, and the Apple Wireless Keyboard and Apple Wireless Mouse
(available for purchase at www.apple.com/store).
Power indicator light
A white light indicates that the computer is on. A pulsing light indicates the computer is in sleep.

-

Volume controls
Increase or decrease the volume of the sound coming from the built-in speakers and sound output
port.
Media Eject key
Press and hold this key to eject a CD or DVD disc. You can also eject a disc by dragging its desktop
icon to the Trash.
Apple Mouse
A precision optical mouse you can use on almost any surface, no mouse pad required.

Chapter 2 Getting to Know Your eMac
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eMac – Side View

Security slot
Memory access
(inside)

Power port

Headphone
jack

Audio line-in
port
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® Power
button

USB 2.0
ports

FireWire
400 ports
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port

Ethernet
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Video output
port
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Memory access (inside)
Your eMac comes with at least 256 megabytes (MB) of Double Data Rate Synchronous Dynamic
Random Access Memory (DDR-SDRAM). There are two memory slots, one of which is usually available
for expansion. The maximum amount of memory you can have in your eMac is 1 gigabyte (GB), using
two 512 MB memory modules. For instructions, see “Installing Additional Memory” on page 37.

f

Headphone port
Connect external speakers, headphones, or other sound output devices.
Audio line in port
Connect your eMac to a line-level microphone or other audio equipment.
Three USB (Universal Serial Bus) 2.0 ports
Connect printers, Zip and other disk drives, digital cameras, joysticks, and more. Connect original USB
1.1 and high-speed USB 2.0 devices. (There are also two USB 1.1 ports on your keyboard.)
Two FireWire 400 ports
Connect high-speed external devices, such as an iPod, digital videocameras, printers, and external
storage devices.

W

Modem port (on some models)
Connect a standard phone line directly to the internal 56K v.92 modem.

G Ethernet port (10/100Base-T)
Connect to a high-speed 10/100Base-T Ethernet network, a DSL or cable modem, or connect to
another computer and transfer files. The Ethernet port auto-sensing feature detects other Ethernet
devices. You don’t need an Ethernet crossover cable to connect to other Ethernet devices.
Video out port
Using the optional Apple VGA Display Adapter (available at www.apple.com/store), connect to an
external monitor or projection device that uses a VGA connector. Using the optional Apple Video
Adapter (available at www.apple.com/store), connect your eMac to a television, VCR, or another video
device that uses an S-video or composite video connector.

®

Power button
Turn on your eMac or put it to sleep. Press and hold to reset during troubleshooting.

≤ Power socket
Connect the computer’s power cord.
Security slot
Protect your eMac by connecting a security cable.

Chapter 2 Getting to Know Your eMac
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Learning About Mac OS X
Your computer comes with Mac OS X and features Classic, an environment for using
Mac OS 9 applications while the computer is running Mac OS X.
Note: Mac OS 9 cannot be installed as the primary operating system on your eMac.
Mac OS X features include an elegant user interface, advanced graphics capabilities,
and added system stability and performance.

When you’re ready to learn more about Mac OS X and the applications that came with
your computer, see the Welcome to Panther booklet that came with your eMac. Also
open Mac OS Help and browse the information there. You’ll find plenty of information
for new users, experienced users, and people switching to the Mac. If you experience
any problems while using Mac OS X, see the troubleshooting tips in the back of this
book or choose Help > Mac Help from the menu bar at the top of the screen.
For information about the compatibility of software applications with Mac OS X, or to
read more about Mac OS X, check the Apple website: www.apple.com/macosx.

16
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Customizing Your Desktop and Setting Your Preferences
You can quickly make your desktop look the way you want using System Preferences.
Choose Apple (K) > System Preferences from the menu bar.

Feel free to make changes and experiment with the following:
• Desktop & Screen Saver: Select this preference pane to change the background
color or pattern of your desktop, or change it to a photo or image you like. You can
also choose an eye-catching screen effect that will appear on your screen when the
computer is left idle.
• Dock: Select this preference pane to change the look, location, and behavior of
your Dock.
• Appearance: Select this preference pane to change the colors of buttons, menus,
windows, and highlight colors, among other options.
As you get to know your computer, explore the other System Preferences. It is your
command center for most settings on your eMac. For more information, open Mac OS
Help and search for “System Preferences” or for the specific preference you want to
change.

Chapter 2 Getting to Know Your eMac
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Connecting to a Printer
To use a printer with your eMac, follow the instructions that came with the printer to
install required software and connect the printer. Many printers connect via a USB
cable; others are accessed via a network connection, such as Ethernet. For more
information about your USB ports, see “Ethernet (10/100Base-T)” on page 29. For more
information about a network or wireless connection, see “Ethernet (10/100Base-T)” on
page 29 and “AirPort Extreme Wireless Internet and Networking” on page 28.
After connecting and setting up your printer, use the Print & Fax pane of System
Preferences to select your printer for use. If you’re connecting to a printer via a network,
you may need to know the network name or address of the printer to select it. If you
have a USB printer connected to an AirPort Extreme Base Station, and you have an
AirPort Extreme Card installed in your eMac, you can connect to the printer and print
wirelessly.
To set up a printer:
1 Open System Preferences and click the Print & Fax icon.
2 Click the Set Up Printers button.
3 Click the Add button.
4 Choose the type of connection for your printer (for example, USB, AppleTalk, and
so on).

To add a USB printer connected to an AirPort Extreme Base Station, choose Rendezvous
from the pop-up menu.
5 Select or enter your printer information and click Add.

18
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Monitoring Printing
Once you’ve sent a document to a printer, you can monitor printing and halt or put it
temporarily on hold.
m

To monitor printing:
Click the Printer icon in the Dock to open the Printer window.
You can now see the print jobs in the print queue and work with them. For more
information, open Mac OS Help (see page 22) and search for “printing.”

Playing a CD and Connecting Headphones
If you’d like to listen to music while you work with your eMac, insert a music CD in your
optical drive. iTunes, an easy-to-use music player, will appear automatically on the
screen. You can also connect headphones with a minijack to the headphone port of
your eMac to listen privately. To learn more about iTunes, open iTunes and choose
Help > iTunes and Music Store Help. To learn more about your optical drive, see “Using
Your Optical Drive” on page 32.

Keeping Your Software Up to Date
You can connect to the Internet and automatically download and install the latest free
software versions, drivers, and other enhancements from Apple.
When you are connected to the Internet, Software Update checks Apple’s Internet
servers to see if any updates are available for your computer. You can set your Mac to
check the Apple server periodically and download and install updated software.
To check for updated software:
1 Choose Apple (K) > Software Update. The Software Update window opens. If there are
any updates available, they appear in a list.
2 Click the checkbox to select the items you want to install, then click Install. Type an
administrator name and password (the name and password you used when you first
set up your computer).
• For more information, search for “Software Update” in Mac OS Help (see page 22).
• For the latest information on the Mac OS, go to the Mac OS website at

www.apple.com/macos.

Chapter 2 Getting to Know Your eMac
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Connecting a Digital Videocamera or Other FireWire
Device
If you have an iPod, iSight camera, digital videocamera, or other device that has a
FireWire connector, you can connect it to your eMac. Follow the installation instructions
that came with your device. For more information about FireWire, see “FireWire” on
page 26.

Connecting to a Network
If you want to connect your eMac to an Ethernet network, cable or DSL modem, or a
wireless network, see “Ethernet (10/100Base-T)” on page 29 and “AirPort Extreme
Wireless Internet and Networking” on page 28 for more information about setting up
an Ethernet or AirPort connection. Also open Mac OS Help (see page 22) and search for
“Ethernet” or “AirPort” for further help.

Connecting to the Internet
When you first set up your eMac, you were instructed on how to connect to the
Internet. If you need to change to a different type of connection, such as DSL, cable
modem, Ethernet local area network (LAN), or AirPort Extreme network, you can find
more information in Appendix C, “Connecting to the Internet,” on page 61.

Transferring Files to Another Computer
If you want to transfer files or documents to or from your eMac, you have several ways
of doing it.
• If you have an iPod or iPod mini, you can transfer files to the iPod and then connect
the iPod to the other computer and transfer the files from the iPod to the other
computer. See the manual that came with your iPod for more information.
• You can transfer files via the Internet using .Mac or another Internet account.
• You can transfer files to another computer on a network. To access another server or
computer, choose Go > Connect to Server from the Finder menu bar.
• You can create a small Ethernet network by connecting an Ethernet cable from your
eMac to another computer’s Ethernet port. For more information, open Mac OS Help
and search for “Connecting two computers.”
• You can also connect to another Mac using a FireWire cable. Your eMac appears as a
disk drive on the other computer and you can transfer files. For information about
using FireWire to transfer files, see “FireWire Target Disk Mode” on page 27.
• If your computer has an AirPort Extreme Card, you can connect to an AirPort Extreme
wireless network to transfer files. For more information, see “AirPort Extreme Wireless
Internet and Networking” on page 28.

20
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When an Application Freezes
On rare occasions, an application may freeze on the screen. Mac OS X provides a way to
quit a frozen application without restarting your computer. Quitting a frozen
application may allow you to save your work in other open applications.
To force an application to quit:
1 Press Command (x)-Option-Esc.
The Force Quit Applications dialog appears with the application selected.

2 Click Force Quit.
The application quits, leaving all other applications open.
If needed, you can force the Classic Environment to quit, which closes all Classic
applications. You can also restart the Finder from this dialog.
If you’re experiencing other problems, see Chapter 5, “Troubleshooting,” on page 49.

Chapter 2 Getting to Know Your eMac
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Getting Answers to Your Questions Using Mac OS Help
You can find answers to most of your questions about using your computer and
Mac OS X using Mac OS Help onscreen.

To use Mac OS Help:
1 Click the Finder icon in the Dock.
2 Choose Help > Mac Help (click the Help menu and choose Mac Help).
3 Type a question and press the Return key on your keyboard.
4 Double-click an item in the list of Help topics.

22
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3

Using Your Computer

3

Your eMac has many built-in features and expansion
capabilities you can use to customize your computer to
fit your needs.
Here are some of your computer’s features and capabilities:
• Universal Serial Bus (USB) 2.0 ports for connecting additional equipment, such as
printers, scanners, joysticks, keyboards, digital cameras, and floppy disk drives.
• FireWire ports for connecting high-speed equipment, such as an iPod, iSight camera,
digital videocameras, and external hard drives.
• Optional Bluetooth module for connecting wirelessly to digital devices.
• The latest in communications technologies, such as a 56K v.92 modem (on some
models), 10/100Base-T Ethernet, and optional AirPort Extreme wireless Internet and
networking.
• VGA output with the Apple VGA Display Adapter (available at www.apple.com/store)
lets you use your eMac with an external monitor or video projector. Use your eMac’s
video out port and the Apple Video Adapter (available at www.apple.com/store) to
present what’s on your computer’s screen on any television that supports composite
or S-video.
• Audio line in port, headphone port, and more.
To learn about what you can do with your eMac, start with the information in this
chapter. Additional information can be found in Mac OS Help (see page 22) and on the
many Apple websites.

23
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Universal Serial Bus (USB)
Your eMac comes with five USB ports ( ) (three high-speed USB 2.0 ports on the
computer and two USB 1.1 ports on the keyboard), which you can use to connect many
types of external devices, including printers, scanners, digital cameras, game pads,
joysticks, keyboards, and floppy disk drives. USB makes it easy to connect external
equipment. In most cases you can connect and disconnect a USB device while the
computer is running. Once you connect the device, it is ready to use.

Using USB Devices
To use a USB device with your computer, simply connect the device to the computer.
Your computer automatically accesses the necessary software whenever you connect a
new device.
You can connect original USB 1.1 devices and high-speed USB 2.0 devices to the
USB 2.0 ports on the side of your computer. USB 1.1 devices won’t take advantage of
the USB 2.0 higher transfer rate.
Likewise, you can connect USB 2.0 devices to the USB 1.1 ports on your keyboard, but
they will operate at significantly slower speeds.
Note: Apple has already included software to work with many USB devices. When you
connect a USB device, if your eMac cannot find the correct software, you can install the
software that came with the device or check the device manufacturer’s website for the
latest software.

24
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Using Multiple USB Devices at the Same Time
If all of your USB ports are being used and you want to connect more USB devices,
you can purchase a USB hub. The USB hub connects to an open USB port on your
computer and provides additional USB ports (usually four or seven). Most USB hubs
also have a power adapter and should be plugged into an outlet.

USB hub

For More Information on USB
Additional information on USB is available in Mac OS Help (see page 22).
Choose Help > Mac Help and search for “USB.” You can also find information
on the Apple USB website at www.apple.com/usb.
For information on USB devices available for your computer, check the Macintosh
Products Guide at www.apple.com/guide.

Chapter 3 Using Your Computer
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FireWire
Your computer has two FireWire 400 ports ( ). FireWire lets you easily connect and
disconnect external high-speed devices—such as an iPod, an iSight camera, DV
cameras, printers, scanners, and hard disks. You can connect and disconnect FireWire
devices without restarting your computer.

These are some of the things you can do with FireWire:
• Connect an iPod and transfer thousands of songs from iTunes or synchronize contact
and calendar information using iSync. You can also use iPod as an external hard disk,
to transfer files.
• Connect a digital videocamera and capture, transfer, and edit high-quality video
directly on your computer using video-editing software such as iMovie, Final Cut Pro,
or Final Cut Express.
• Connect an external FireWire hard disk drive and use it to back up data or transfer
files.
A FireWire hard disk icon appears on your desktop after you connect the drive to
your eMac.
• Start up from an external FireWire hard disk. Connect an external FireWire disk (with

a valid operating system installed on it), open the Startup Disk pane of System
Preferences, and click the FireWire disk. Restart your computer.

26
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Using FireWire Devices
To use a FireWire device with your computer, simply connect the device to the
computer. Apple has already included software to work with many FireWire devices.
When you connect a FireWire device, if your eMac cannot find the correct software, you
can install the software that came with the device or check the device manufacturer’s
website for the latest software.
Note: The FireWire port is designed to provide power for FireWire devices (up to
8 watts maximum). You can connect multiple devices to each other and connect the
“daisy-chain” of devices to the FireWire port on your computer. In most cases, at most
two devices should get power from the computer. If you connect more than two
devices, the rest of the devices in the daisy-chain should be powered by separate
power adapters. Connecting more than two FireWire devices that get power from
the computer may cause problems. If a problem occurs, shut down the computer,
disconnect the FireWire devices, and restart your computer.

FireWire Target Disk Mode
If you want to transfer files between your eMac and another FireWire-equipped
computer, or you have a problem that prevents your computer from starting up, you
can use FireWire Target Disk Mode to connect to another computer.
To connect your eMac in FireWire Target Disk Mode, follow these steps:
1 Make sure that your eMac is shut down.
2 Use a FireWire cable with a standard 6-pin connector on each end to connect your
eMac to another FireWire-equipped computer.
3 Start up your eMac and immediately hold down the T key. Your eMac display shows
the FireWire logo. The other computer’s display shows the eMac internal hard disk
icon and the icon of a CD or DVD disc in the eMac’s optical drive.
4 When you are finished transferring files, drag the eMac hard disk icon and the CD or
DVD disc icon to the Trash.
5 Press the Power button on the eMac to shut it down, and then disconnect the
FireWire cable.

For More Information on FireWire
Additional information on FireWire is available in Mac OS Help (see page 22).
Choose Help > Mac Help and search for “FireWire.” You can also find information
on the Apple FireWire website at www.apple.com/firewire.
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AirPort Extreme Wireless Internet and Networking
Your eMac is AirPort Extreme-ready. If you ordered an AirPort Extreme Card when you
purchased your eMac, the card is already installed. If you do not have an AirPort
Extreme Card installed and would like to install one, see page 41 for more information.
AirPort offers an easy and affordable way to provide wireless Internet access anywhere
in the home, at work, or in the classroom. Instead of using traditional cables, AirPort
uses wireless local area network (LAN) technology to provide wireless communication
between multiple computers. Through a wireless network you can set up access to the
Internet, transfer files, play multiplayer games, and more.
Note: Wireless Internet access requires an AirPort Extreme Card. Previous models of
AirPort Card are not compatible with your computer. You also need an AirPort Extreme
Base Station or AirPort Base Station and Internet access (fees may apply). Some Internet
service providers are not currently compatible with AirPort. Range may vary with site
conditions.

How AirPort Provides Wireless Internet Access
With AirPort, you set up a wireless connection to a device known as a base station,
which has a physical connection to the Internet. AirPort technology works like a
cordless telephone. The AirPort Extreme Card in the computer makes a wireless
connection to the base station, which is connected to the Internet via a telephone line
or a DSL or cable modem.
Connection to the Internet
AC outlet
AirPort Extreme
Base Station
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For More Information on AirPort
To purchase an AirPort Extreme Base Station, contact your Apple-authorized dealer or
go to the Apple Store at www.apple.com/store.
Additional information on AirPort is available in AirPort Help. Choose Help > Mac Help,
then choose Library > AirPort Help. You can also find information on the Apple AirPort
website at www.apple.com/airport and in the Apple Knowledge Base at
kbase.info.apple.com.

Bluetooth Wireless Technology
If your eMac has the optional Bluetooth® module, you can connect wirelessly
to devices, such as Bluetooth enabled mobile phones, digital cameras, and the
Apple Wireless Keyboard and Apple Wireless Mouse (available for purchase at
www.apple.com/store).
For more information about using Bluetooth wireless technology, open Bluetooth
File Exchange in the Utilities folder (inside the Applications folder) and choose
Help > Bluetooth Help.

Ethernet (10/100Base-T)
Your computer comes with built-in 10/100 megabit per second (Mbps) Base-T
(twisted-pair) Ethernet networking capability, which you can use to connect to a
network or to a cable or DSL modem.
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Connecting to a network gives you access to other computers. You may be able to
store and retrieve information; use network printers, modems, and electronic mail; or
connect to the Internet. You can also use Ethernet to share files between two
computers or set up a small network. The Ethernet port on your eMac automatically
detects other Ethernet devices. You don’t need an Ethernet crossover cable to connect
to other Ethernet devices.
• Use 2-pair category 3 (Cat 3) Ethernet cables to connect to a 10Base-T Ethernet
network.
• Use 2-pair category 5 (Cat 5) Ethernet cables to connect to a 10Base-T or a 100Base-T
Ethernet network.

For More Information on Using Ethernet
Additional information, including how to set up an Ethernet network and transfer files
using Ethernet, is available in Mac OS Help (see page 22). Choose Help > Mac Help and
search for “Ethernet” or “network.”
For information on networking products you can use with your eMac, check the
Macintosh Products Guide at www.apple.com/guide.

External Video Support (VGA, Composite, and S-Video)
Your computer has a video out port you can use to connect an external display
(monitor) or VGA projector, using the Apple VGA Display Adapter (available at
www.apple.com/store).
You can also display or record computer images by connecting a TV, video projector, or
videocassette recorder (VCR), using the Apple Video Adapter (available at
www.apple.com/store).
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Note: The Apple Video Adapter is not compatible with some previous models of eMac.

Apple VGA adapter

Æ S-video out port
Composite video port

Apple Video adapter
Æ

When an external monitor or television is connected, the same image appears on
both the eMac display and the external monitor (known as video mirroring).
Note: Because of the display limitations of most televisions, images displayed on
a television screen are of lower quality than those on the built-in display or
external monitor.

Connecting an External Display or Projector
To connect an external display or projector to your computer with a VGA
connector:
1 Turn on the external display or projector.
2 Connect the Apple VGA Display Adapter to the VGA port on the external display or
projector.
3 Connect the Apple VGA Display Adapter to your eMac. Your eMac automatically detects
the external display.
Important: To ensure that your eMac automatically detects the external display
or projector, be sure the VGA adapter is plugged into the external display or projector
first.
4 Use the Displays pane of System Preferences to adjust the resolution on the external
display or projector.
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Connecting a Television, VCR, or Other Video Device
To connect a TV, VCR, or other video device to the eMac:
1 Connect the single-plug end of the Apple Video Adapter to the video out port on
your eMac.
2 Connect the other end of the adapter to the composite video port or the S-video port
on the TV or VCR using a composite or S-video cable.
3 Turn on the external device.
4 To adjust how the images are displayed on the device, use the Displays pane of System
Preferences.
The image appears on both the eMac and the TV, except for DVD playback, which
appears only on the TV.

For More Information on Using an External Display or TV
Additional information on using and configuring an external monitor is available in
Mac OS Help. Choose Help > Mac Help and search for “display.”

Using Your Optical Drive
You can install or use software from CDs using your optical drive. You can play
multimedia content (such as QuickTime movies) from CD discs and music from
audio CDs.
If your eMac has a DVD/CD-RW Combo drive or a SuperDrive, you can burn music CDs,
and save documents and other digital files on CD-R and CD-RW discs. You can also play
DVD movies and use most DVD discs.
If your eMac has a SuperDrive, you can also use your home movies to make video DVDs
that can by played in most home DVD players, or save documents to blank DVD-R
(recordable DVD) discs.
Note: If you have older software that comes on floppy disks, contact the software
manufacturer to see if the software is available on a CD or for download from the web,
or purchase an external USB floppy disk drive for your eMac from your Apple dealer or
the Apple Store (www.apple.com/store).
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Inserting a CD or DVD Disc
To install or use programs from a CD or DVD disc, follow these steps:
1 With the computer turned on, press the Media Eject key ( ) on the keyboard to open
the drive tray.
2 Place the disc flat on the tray, with the label facing up, and press the Media Eject key
again to close the tray.
Note: Some DVD discs are two-sided.

3 When the icon for the disc appears on the desktop, the disc is ready to use.

Ejecting a Disc
To eject a disc, do one of the following:
• Drag the disc icon to the Trash.
• Press and hold the Media Eject ( ) key on the keyboard until the disc ejects.
If you can’t eject the disc, quit any applications that may be using the disc and try
again. If that doesn’t work, restart the computer while holding down the mouse
button.
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Playing DVD Discs
If your eMac has a DVD/CD-RW Combo drive or a SuperDrive, you can play standard
DVD-Video discs. To play a DVD, insert the DVD disc. DVD Player opens automatically
and starts playing the disc.
If your eMac is connected to a TV so that you can watch DVD playback on the TV
screen, select 720 x 480 NTSC (in the United States) or 720 x 576 PAL (in Europe and
other regions) in the Displays pane of System Preferences.
You can easily connect your eMac to your stereo system. Use a 3.5-millimeter miniplugto-RCA cable (not included) to connect the headphone port (f ) on your eMac to the
audio input ports on your stereo.

Recording CD-R and CD-RW Discs
If your eMac has a DVD/CD-RW Combo drive or a SuperDrive, you can record music on
CD-R or CD-RW discs right from your iTunes library.
To record music to a CD-R or CD-RW disc:
1 Click the iTunes icon in the Dock.
2 Select the playlist you want to record.
3 Insert a blank CD-R or CD-RW disc. (For highest compatibility with CD players,
use a CD-R disc.)
4 At the top of the iTunes window, click Burn CD.
You can also record data on CD-R and CD-RW discs:
1 Insert a blank disc in the optical drive.
2 In the dialog that appears, enter a name for the disc. An icon for the CD appears on the
desktop.
3 Drag files and folders to the disc icon.
4 Choose File > Burn Disc, or select the disc and drag it to the Burn Disc icon in the Dock.

For More Information
• For information about how to use iTunes to record music files on a CD-R disc,

open iTunes and choose Help > iTunes and Music Store Help.
• For instructions on using DVD Player, open DVD Player and choose

Help > DVD Player Help.
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Recording Information on a DVD
If your eMac has a SuperDrive, you can record your own digital movies on a blank
DVD-R (DVD-Recordable) disc. You can also record other kinds of digital data (for
example, you can back up your files to DVD-R discs).
With iDVD, you can create your own customized DVD, burn it on a blank DVD-R disc,
and play it on most standard DVD players.
To burn an iDVD project to a blank DVD:
1 Open iDVD and open your completed DVD project.
2 Click the Burn button.
3 Insert a new blank DVD-R disc into the drive when prompted.
4 Click the Burn button again.
To record data to a DVD-R disc:
1 Insert a blank DVD-R disc in the drive.
2 In the dialog that appears, enter a name for the disc and select the format you want to
create. An icon for the DVD appears on the desktop.
3 Double-click the DVD icon, then drag files and folders to it.
4 Choose File > Burn Disc, or select the disc and drag it to the Burn Disc icon in the Dock.
For more information about how to use iDVD, open iDVD and choose Help > iDVD
Help.

Keyboard Controls
You can quickly adjust the volume or eject a CD or DVD disc using the keyboard
controls.
Mute key

Volume Down key

Media Eject key

Volume Up key

To increase display contrast, press the F15 key on your keyboard. To decrease contrast,
press F14.
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Securing Your Computer
Use a locking cable and the built-in security slot to attach your eMac to a stationary
object.

Sample locking device
with security cable

Additional information on the software security features of your eMac, including
multiple user passwords and file encryption, is available in Mac OS Help (see page 22).
Choose Help > Mac Help and search for “security” or “multiple users.”
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4

Enhancing Your Computer

4

This chapter provides information and instructions for
enhancing your computer.
Instructions are provided for the following procedures:
• “Installing Additional Memory” on page 37
• “Installing an AirPort Extreme Card” on page 41
Warning: Apple recommends that you have an Apple-certified technician install
memory. Consult the service and support information that came with your computer
for instructions on how to contact Apple for service. If you attempt to install memory
and damage your equipment, such damage is not covered by the limited warranty on
your computer.

Installing Additional Memory
Your eMac comes with at least 256 megabytes (MB) of Double Data Rate Synchronous
Dynamic Random Access Memory (DDR-SDRAM). There are two memory slots, one of
which is usually available for expansion. Each memory slot accepts any memory
module that meets the following specifications:
• Double Data Rate Synchronous Dynamic Random Access Memory (DDR-SDRAM)
• PC-2700 (commonly referred to as DDR-333)
• 184 pin DIMMs
• +2.5V
• Unbuffered/Unregistered
The maximum amount of RAM you can have in your eMac is 1 gigabyte (GB), using two
512 MB memory modules.
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To install additional memory:
1 Turn your computer off by choosing Apple (K) > Shut Down. Disconnect all cables
except the power cord from your computer.
2 Place a soft, clean towel or cloth on the desk or surface. Slowly lift up and turn the
computer so the screen is facing down on the cloth.

3 Use a Phillips screwdriver to loosen the captive screw on the memory access panel.
Then gently remove the access panel.
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4 Touch metal inside the computer to protect the computer from damage caused by
electrostatic discharge.

Important: Always discharge static electricity before you touch any parts or install any
components inside the computer. To avoid generating static electricity, do not walk
around the room until you have finished installing the memory and closed the
computer.
5 Disconnect the power cord from the computer.
6 Insert the memory module into the memory slot. The module fits into the slot only one
way. Be sure to align the notch on the module with the small notch inside the slot.
With the ejectors in the open position, push down on the memory module until it locks
into place. The ejectors will automatically close.
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7 Hold the access panel against the base of the computer and tighten the screw.

8 Gently turn the computer right side up. Then reconnect the cables you disconnected
from your computer.
9 Press the Power button on the side of your computer to turn it on.
Warning: Operating the computer when it is open or missing parts can be dangerous
and could damage your computer.

Making Sure Your Computer Recognizes the New Memory
After installing additional memory in your eMac, check whether the computer
recognizes the new memory. Do the following:
1 Start up your computer.
2 When you see the Mac OS desktop, choose Apple (K) > About This Mac.

Total memory installed
in your eMac
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The total includes the amount of memory that originally came with the computer plus
the new memory you added. For a more detailed breakdown of the amount of
memory installed in your computer, open Apple System Profiler by clicking More Info.
If your computer doesn’t recognize the memory or it doesn’t start up correctly, shut
down your eMac and check the instructions again to make sure that the memory you
installed is compatible with this eMac and that it is installed correctly. If you still have
problems, remove the memory and consult the support information that came with
the memory or contact the vendor who provided the memory.

Installing an AirPort Extreme Card
If your computer did not come with an AirPort Extreme Card, you can purchase one
from your Apple-authorized dealer or from the Apple Store at www.apple.com/store
and install it yourself or have it installed by an Apple-authorized service provider.
Note: Your eMac is not compatible with older AirPort Cards. Use only an AirPort
Extreme Card.
To install an AirPort Extreme Card in your eMac:
1 Press the Media Eject key ( ) on the keyboard to open the access door. Then hold the
door open and press the eject key again to retract the drive tray.

2 While continuing to hold the door open, turn your computer off by choosing
Apple (K) > Shut Down.
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3 Loosen the captive screws on the AirPort access panel using a Phillips screwdriver. Then
remove the panel and unhook the antenna from the panel.

4 Insert the AirPort Extreme Card partially into the slot, with the logo facing down, then
connect the antenna firmly to the card.
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5 Push the AirPort Extreme Card firmly into the slot and tuck the antenna down into the
computer. You may need to lift the card slightly as you push it in.

Important: Be sure to push the AirPort Extreme Card firmly all the way into the slot.
6 Tuck the tab on the AirPort Extreme Card down into the computer.
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7 Replace the AirPort access panel.

8 Press the Power button on the side of your computer to turn it on.
If there is an AirPort network in range, you can select it using the AirPort status icon in
the menu bar. If you want to set up an AirPort Base Station, use the AirPort Setup
Assistant, in Applications/Utilities.

Replacing the Internal Backup Battery
Your computer has a backup battery that preserves certain settings, such as the date
and time, when the computer is off.
You may need to replace the battery if you have intermittent problems starting up your
computer, or if settings such as the date and time change when you start up your
computer.
You can purchase a replacement 3.6V, 1/2AA leadless lithium battery at most
electronics or computer stores.
Note: If your computer is plugged into a power strip, Apple recommends you leave the
strip turned on to avoid shortening battery life.
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To replace the internal backup battery:
1 Turn your computer off by choosing Apple (K) > Shut Down. Disconnect all cables
except the power cord from your computer.
2 Place a soft, clean towel or cloth on the desk or surface. Slowly lift up and turn the
computer so the screen is facing down on the cloth.

3 Use a Phillips screwdriver to loosen the captive screw on the memory access panel.
Then gently remove the access panel.
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4 Touch metal inside the computer to protect the computer from damage caused by
electrostatic discharge.

Important: Always discharge static electricity before you touch any parts or install any
components inside the computer. To avoid generating static electricity, do not walk
around the room until you have finished installing the memory and closed the
computer.
5 Disconnect the power cord from the computer.
6 Remove the internal backup battery and replace it with the new one. Make sure to
align the plus sign (+) on the battery with the one inside the computer.
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7 Locate the Power Management Unit reset button inside the computer. Push the button
for one second using a pen or pencil.

8 Hold the access panel against the base of the computer and tighten the screw.
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9 Gently turn the computer right side up. Then reconnect the cables you disconnected
from your computer.
10 Press the Power button on the side of your computer to turn it on.
Warning: Operating the computer when it is open or missing parts can be dangerous
and could damage your computer.
11 Dispose of the old battery according to your local environmental guidelines.
Replacing the battery may cause some settings on your computer, such as date and
time, to revert to the factory default settings. You may also have to restore modem
settings in any communications programs you use.
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5

Troubleshooting

5

Occasionally you may have problems while working with
your eMac. This chapter gives you some solutions to try
when you have a problem.
Most problems occur because your software isn’t properly set up or you’re using
software that isn’t compatible with the version of the Mac OS (system software)
installed on your computer. Other less likely sources include problems with the Mac OS
or problems with your computer’s hardware, such as the memory or hard disk.
When you experience a problem with your computer, it’s important to remember that
there is usually a simple and quick solution. When you encounter a problem, be aware
of the conditions that led up to the problem. Making a note of things you did before
the problem occurred will help you narrow down the possible causes of the problem
and then find the answers you need. Things to note include:
• The applications you were using when the problem occurred. Problems that occur
only with a specific application may indicate that the application is not compatible
with the version of the Mac OS installed on your computer.
• Any software that you recently installed. Certain applications install extensions that
may not be compatible with the Classic environment.
• Any new hardware (such as additional memory or a peripheral) that you connected
or installed.
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Problems That Prevent You From Using Your Computer
If the computer won’t respond or the pointer won’t move
• First, make sure the mouse and keyboard are connected. Unplug and then plug in
the connectors and make sure they are secure.
• If that doesn’t work, try to force problem applications to quit. Hold down the Option
and Command (x) keys and then press the Esc key. If a dialog appears, select the
application and click Force Quit. Then save your work in any open applications and
restart the computer to be sure the problem is entirely cleared up.
• If you are unable to force the application to quit, press and hold the Power button
(®) for a few seconds to shut down the computer.
• If that doesn’t work, unplug the power cord from the computer. Then plug the power
cord back in and press the Power button (®) on the computer to turn it on.
If the problem occurs frequently when you use a particular application, check with the
application’s manufacturer to see if it is compatible with your computer.
For support and contact information about the software that came with your
computer, go to www.apple.com/guide.
If the problem occurs frequently, you may need to reinstall your system software (see
“Restoring Your Computer’s Software” on page 51).
If the computer freezes during startup or you see a flashing question mark
• Wait a few seconds. If the computer doesn’t start up after a delay, shut down your
computer by pressing and holding the Power button (®) for about 5 seconds, until
the computer shuts down. Then hold down the Option key and press the Power
button (®) again to start up your computer. When your computer starts up, click the
hard disk icon, then click the right arrow.
• After the computer starts up, open System Preferences and click Startup Disk. Select
a local Mac OS X System folder.
• If the problem occurs frequently, you may need to reinstall your system software (see
“Restoring Your Computer’s Software” on page 51).
If the computer won’t turn on or start up
• Make sure the power cord is plugged into the computer and into a functioning
power outlet.
• If that does not work, press the Power button (®) and immediately hold down the
Command (x), Option, P, and R keys until you hear the startup sound a second time.
• If you recently installed additional memory, make sure that it is correctly installed
and that it is compatible with your computer. See whether removing it allows the
computer to start up (see page 37).
• If you are still unable to start up your computer, see the service and support
information that came with your eMac for information on contacting Apple for
service.
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Restoring Your Computer’s Software
Use the Software Install and Restore discs that came with your computer to reinstall
Mac OS X, applications, or Classic support. Some models of eMac come with a series of
Software Install CDs and another series of Software Restore CDs, and some models
come with a single series of Software Install and Restore DVDs.
m

To restore all of your computer’s software:
Follow the instructions below to reinstall Mac OS X, then follow the instructions to
reinstall applications and Classic support.

Reinstalling Mac OS X
1 Back up essential files, if possible.
2 Insert the first Software Install and Restore disc (or the first Software Install disc) that
came with your computer.
3 Double-click the Install Mac OS X icon.
4 Follow the onscreen instructions.
5 After selecting the destination disk for installation, click Options and continue following
the onscreen instructions.

Reinstalling Applications and Classic Support
To reinstall applications and Classic support if your eMac came with two
Software Install and Restore DVDs:
1 Back up essential files, if possible.
2 Insert the first Software Install and Restore disc that came with your computer.
3 Double-click the “Install Applications and Classic Support” icon.
4 Follow the onscreen instructions.
To reinstall applications and Classic support if your eMac came with multiple
Software Install and Software Restore CDs:
1 Back up essential files, if possible.
2 Insert the first Software Restore disc. Double-click the “SoftwareRestore.pkg” icon to
install the Software Restore application.
3 Follow the onscreen instructions to restore your computer’s software.
Note: iCal, iChat AV, iMovie, iPhoto, iSync, iTunes, and Safari are part of Mac OS X. To
install them you must follow the directions for installing Mac OS X (above).
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Other Problems
If you have a problem with an application
• For problems with software from a manufacturer other than Apple, contact the
manufacturer. Software manufacturers often provide updates to their software on
their websites. You can configure your eMac to automatically check for and install the
latest Apple software using the Software Update pane of System Preferences. For
more information, choose Help > Mac Help and search for “software update.”
If you have trouble using AirPort wireless communication
• Make sure you have properly configured the software according to the instructions
that came with your AirPort Extreme Card or AirPort Base Station.
• Make sure the computer or network you are trying to connect to is running and has
a wireless access point.
• Make sure you are within antenna range of the other computer or the network’s
access point. Nearby electronic devices or metal structures can interfere with wireless
communication and reduce this range. Repositioning or rotating the computer may
improve reception.
• Check the AirPort signal level. There are up to four bars in the AirPort status icon in
the menu bar.
• You may experience network performance problems if a microwave oven, cordless
phone, or other source of interference is used frequently near your base station. To
minimize interference, move the base station away from the device.
• For more information on using and troubleshooting AirPort, choose Help > Mac Help,
then choose Library > AirPort Help.
If you have trouble ejecting a disc
• Quit any applications that may be using the disc and try again. If that doesn’t work,
restart the computer while holding down the mouse button.
If you have problems with your Internet connection
• Make sure your telephone line or network cable is connected and functioning
properly.
• If you are using a dialup Internet connection, make sure that your telephone cord is
plugged into the modem port (marked with the icon W) and not the Ethernet port
(marked with the icon G).
• See “Connecting to the Internet” on page 61 for information on setting up your
computer to connect to the Internet. There you will find how to locate your Internet
settings and the contact information for your Internet service provider (if you used
the Setup Assistant to get your Internet account).
• See “Troubleshooting Your Connection” on page 77 for more information if you have
problems with your Internet connection.
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If you have a problem using your computer or working with the Mac OS
• If the answers to your questions are not in this manual, look in Mac OS Help for
instructions and troubleshooting information.
• Check the Apple Support website at www.apple.com/support for the latest
troubleshooting information and software updates.
If your date and time settings get lost repeatedly
• You may need to replace the internal backup battery. See “Replacing the Internal
Backup Battery” on page 44 for more information.

Apple Hardware Test
If you suspect a problem with your computer hardware, you can use the Apple
Hardware Test application to help determine if there is a problem with one of your
computer’s components, such as the memory or processor.
If your eMac came with two Software Install and Restore DVDs, Apple Hardware Test is
on the first Software Install and Restore DVD. If your eMac came with a series of
Software Install CDs and another series of Software Restore CDs, Apple Hardware Test is
on a separate Apple Hardware Test CD.
To use Apple Hardware Test:
1 Disconnect all external devices from your computer except the keyboard and mouse.
If you have an Ethernet cable connected, disconnect it.
2 Start up your computer using Apple Hardware Test:
• If you have the Apple Hardware Test CD, insert it into your computer. Then restart your

computer and hold down the C key as it starts up.
• If you have two Software Install and Restore DVDs, insert the first disc into your

computer. Then restart your computer and hold down the Option key as it starts up.
A list of available startup volumes appears. Click Apple Hardware Test and click the
right arrow.
3 When the Apple Hardware Test main screen appears after about 45 seconds, follow the
onscreen instructions.
4 If Apple Hardware Test detects a problem, it displays an error code. Make a note of the
error code before pursuing support options. If Apple Hardware Test does not detect a
hardware failure, the problem may be software related.
For more information about Apple Hardware Test, see the Apple Hardware Test Read
Me file on the Apple Hardware Test CD or on the first Software Install and Restore DVD.
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Locating Your Product Serial Number
You can find the serial number for your eMac on the inside of the optical drive door.
Press the Media Eject ( ) key on the keyboard to open the door. If you can’t turn on
your computer, you can open the drive door using your fingernail.
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You can use System Profiler to find out detailed
information about your eMac, such as the amount of
built-in memory, hard disk size, devices connected, and
the product serial number.
To access the information in System Profiler, choose Apple (K) > About This Mac from
the menu bar and then click More Info, or open System Profiler, located in Applications/
Utilities.

Click the triangles in the
window to show and
hide information in the
different categories.

Additional information is available on the Internet at www.apple.com/emac and
www.apple.com/support.
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For your safety and that of your equipment, follow the
rules in this appendix for cleaning and handling your
computer, as well as the guidelines for working more
comfortably.
Cleaning Your eMac
Follow these general rules when cleaning the outside of your computer and its
components:
• Shut down your eMac and disconnect all cables.
• Use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid getting
moisture in any openings. Do not spray liquid directly on the computer.
• Don’t use aerosol sprays, solvents, or abrasives.

Cleaning Your eMac Display
To clean your eMac screen, do the following:
• Shut down your eMac and disconnect all cables.
• Dampen a clean, soft, lint-free cloth or paper with water only and wipe the screen.
Do not spray liquid directly on the screen.
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Carrying Your eMac
Your eMac weighs about 50 pounds (22.7 kilograms). If possible, use two people to
lift it.
If you are lifting your eMac by yourself, stand with the screen facing you and hold the
bottom of the computer with both hands. Lift using your legs, rather than your back.

Safety Instructions for Setting Up and Using Your
Computer
For your own safety and that of your equipment, always take the following precautions.
Disconnect the power plug (by pulling the plug, not the cord) and disconnect the
phone cord if any of the following conditions exists:
• You want to remove any parts
• The power cord or plug becomes frayed or otherwise damaged
• You spill something into the case
• Your computer is exposed to rain or any other excess moisture
• Your computer has been dropped or the case has been otherwise damaged
• You suspect that your computer needs service or repair
• You want to clean the case (use only the recommended procedure described earlier)
Important: The only way to turn off power completely is to disconnect the power cord
and phone cords. Make sure at least one end of the power cord is within easy reach so
that you can unplug the computer when you need to.
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Warning: Your AC cord came equipped with a three-wire grounding plug (a plug that
has a third grounding pin). This plug will fit only a grounded AC outlet. If you are
unable to insert the plug into an outlet because the outlet is not grounded, contact a
licensed electrician to replace the outlet with a properly grounded outlet. Do not
defeat the purpose of the grounding plug.
Be sure that you always do the following:
• Keep your computer away from sources of liquids, such as drinks, washbasins,
bathtubs, shower stalls, and so on.
• Protect your computer from dampness or wet weather, such as rain, snow, and so on.
• Read all the installation instructions carefully before you plug your computer into a
wall socket.
• Keep these instructions handy for reference by you and others.
• Follow all instructions and warnings dealing with your system.
Important: Electrical equipment may be hazardous if misused. Operation of this
product, or similar products, must always be supervised by an adult. Do not allow
children access to the interior of any electrical product and do not permit them to
handle any cables.
Warning: Never push objects of any kind into this product through the openings in
the case. Doing so may be dangerous and result in fire or a dangerous electric shock.

Apple and the Environment
Apple Computer, Inc., recognizes its responsibility to minimize the environmental
impacts of its operations and products.
ENERGY STAR ® Compliance
As an ENERGY STAR® partner, Apple has determined that standard configurations of this
product meet the ENERGY STAR® guidelines for energy efficiency. The ENERGY STAR®
program is a partnership with office product equipment manufacturers to promote
energy-efficiency. Reducing energy consumption of office products saves money and
reduces pollution by eliminating wasted energy.
For More Information
Go to www.apple.com/about/environment.
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Ergonomics
Keyboard
When you use the keyboard, your shoulders should be relaxed. Your upper arm and
forearm should form an angle that is slightly greater than a right angle, with your wrist
and hand in roughly a straight line.
Use a light touch when typing and keep your hands and fingers relaxed. Avoid rolling
your thumbs under your palms.
Change hand positions often to avoid fatigue. Some computer users may develop
discomfort in their hands, wrists, or arms after intensive work without breaks. If you
begin to develop chronic pain or discomfort in your hands, wrists, or arms, consult a
qualified health specialist.
Chair
An adjustable chair that provides firm, comfortable support is best. Adjust the height of
the chair so your thighs are horizontal and your feet flat on the floor. The back of the
chair should support your lower back (lumbar region). Follow the manufacturer’s
instructions for adjusting the backrest to fit your body properly.
You may have to raise your chair so your forearms and hands are at the proper angle to
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a
footrest with adjustable height and tilt to make up for any gap between the floor and
your feet. Or you may lower the desktop to eliminate the need for a footrest. Another
option is to use a desk with a keyboard tray that’s lower than the regular work surface.
Mouse
Position the mouse at the same height as your keyboard and within a comfortable
reach.
Computer
Arrange the computer so the top of the screen is slightly below your eye level when
you’re sitting at the keyboard. The best distance from your eyes to the screen is up to
you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).
Position the computer to minimize glare and reflections on the screen from overhead
lights and windows.
For More Information
Go to www.apple.com/about/ergonomics.
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You can use your computer to browse the World Wide
Web, send email to friends and family, and chat in real
time over the Internet. Use this detailed guide to connect
to the Internet.
When you first start up Mac OS X, the Setup Assistant helps you enter your Internet
configuration information and sign up for an Internet service provider (ISP) if you don’t
already have one.
If you didn’t use the Setup Assistant to configure your Internet connection, you can use
it now. Open System Preferences and click Network. Click the “Assist me” button to
open Network Setup Assistant. If you don’t want to use Network Setup Assistant, you
can use the information in this appendix to set up your connection manually.
There are four kinds of Internet connections:
• Dial-up connection: Your computer is plugged into a telephone wall jack using a
telephone cable (with computers that include a modem).
• High-speed DSL or cable modem connection: Your computer is plugged into a
special modem you get from an ISP using an Ethernet cable.
• AirPort Extreme wireless connection: Your computer is connected wirelessly to the
Internet using an AirPort Extreme Base Station.
• Local area network (LAN): Your computer is plugged into a LAN using an Ethernet
cable. This type of connection is usually used in the workplace.
Before you connect to the Internet:
1 Set up an account with an ISP. If you do not have an ISP account, the Setup Assistant
can help you get one. If you don’t want to use the ISP suggested by the Setup
Assistant, you can find an ISP in your phone directory. Look under “Internet access,”
“Internet service,” or “online.”
Note: If you want to use America Online as your ISP, skip the Internet setup part of the
Setup Assistant. Then open the AOL Installer application (in Applications/Installers) and
follow the onscreen instructions to set up AOL.
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2 Gather the connection information you need from your ISP or network administrator.
See the next section, “Setup Assistant Worksheet” on page 63 to find out what
information to get for each type of connection.
In some cases, if another computer in the same location is already connected to the
Internet, you may be able to use its settings.
To find the settings on a Mac OS X computer:
• Open the Network pane of System Preferences.
• Choose your connection method from the Show pop-up menu.
• Copy the information for your configuration.
To find the settings on a Mac OS 9 computer:
• Open the TCP/IP control panel.
• Find the connection method in the “Connect via” pop-up menu.
• Find the configuration in the “Configure IPv4” pop-up menu.
• Copy the IP address, subnet mask, and router address from the corresponding fields.
To find the settings on a Windows PC:
The connection information on a Windows computer resides in two places.
• To find the IP address and subnet mask, open the “Network and Internet

Connections” control panel.
• To find user account information, open the User Accounts control panel.
You can write the information directly on the next few pages, then enter it in the Setup
Assistant.
3 If you are using a dial-up modem, plug a phone cord (included with most Macintosh
computers) into your computer’s modem port and into a phone wall jack. If you are
using a DSL or cable modem, follow the instructions that came with the modem to
connect it to your computer. Turn on your computer and enter information in the
Setup Assistant to configure your Internet connection.
Note: If you already started your computer and did not use the Setup Assistant to
configure your Internet connection, choose Apple (K) > System Preferences and click
Network. Then click “Assist me.” The Setup Assistant opens.
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Setup Assistant Worksheet
You can write the information you get from your Internet service provider (ISP), your
network administrator, or your other computer on these pages, then enter it in
Network Setup Assistant.
Select how your computer connects to the Internet.
Telephone Modem
Cable Modem
DSL Modem
Local network (Ethernet)

To set up a telephone dial-up connection, enter the following information:
User Name

Password

ISP Phone Number

Dialing prefix to obtain an outside line

To set up a DSL or cable modem or a LAN connection:
1 Choose your connection type. Ask your ISP for this information.
Manually
Manually using DHCP Router
Using DHCP
Using BootP
PPP
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2 Enter information from your ISP:
If you selected “Manually” or “Manually using DHCP Router,”* enter the
following:
IP Address

Subnet Mask

Router Address

* If you selected “Manually using DHCP Router,” you don’t need to enter a subnet mask or router address.

If you selected “Using DHCP,” enter the following:
DHCP Client ID

Note: DHCP Client ID is optional and may not be required. Ask your ISP.
If you selected “PPP (for PPPoE connections),” enter the following:
Service Provider (optional)

PPPoE Service Name (optional)

Account Name

Password

The information below is optional. Ask your ISP if you need to enter it.
DNS Hosts (optional for DHCP & BootP)

Domain Name (optional)

Proxy Server (optional)
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Setting Up Your Internet Connection Manually
Once you have completed the steps on the previous pages using the Setup Assistant,
you are done setting up your Internet connection. If you don’t wish to use the Setup
Assistant, or if you only want to make changes to specific parts of your Internet setup
configuration, you can use the instructions below to set up your connection manually.
To enter your information manually, follow the steps that correspond to your
connection method.
• Dial-up modem with Point-to-Point Protocol (PPP) connection (see page 66)
• Cable modem, DSL, or LAN connection using these configurations:
• Manual (see page 70)
• DHCP (see page 71)
• PPPoE (see page 72)
• AirPort Extreme wireless connection (see page 74)
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Dial-Up Connection
A dial-up modem is the most common way to connect to the Internet. Your modem
uses a method called Point-to-Point Protocol (PPP) to connect to an ISP.
Make sure your modem is plugged into a phone line and you have the information
from your ISP available (see page 63).
To set up Network preferences for the internal modem port:
1 Choose Apple (K) > System Preferences from the menu bar.
2 Click Network.
3 Choose Network Port Configurations from the Show pop-up menu and select the On
checkbox next to Internal Modem.

4 Drag Internal Modem to the top of the Port Configurations list to make it the preferred,
or primary, network interface.
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5 Choose Internal Modem from the Show pop-up menu and click PPP.
6 Enter the information from your ISP and click Apply Now.

To test your Internet configuration:
1 Open the Internet Connect application (in the Applications folder).
2 Click the Internal Modem icon, if necessary.
3 Enter your dial-up telephone number, account name, and password, if necessary.
4 Click Connect.
Internet Connect dials your ISP and establishes a connection.
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To connect automatically when you start an Internet application, such as a
web browser or email:
1 Click PPP Options (in the PPP pane of Network preferences).
2 Select the “Connect automatically when needed” checkbox.

3 Click OK and Apply Now.

DSL, Cable Modem, or LAN Internet Connections
If you connect to the Internet using a DSL or cable modem or Ethernet LAN, ask your
ISP or network administrator how you should configure your Internet connection:
• Manually: With a manual configuration, your ISP or network administrator provides
a static IP address and other information that you enter in Network preferences.
• Using Dynamic Host Configuration Protocol (DHCP): With a DHCP configuration,
the DHCP server automatically enters the information for you.
• Using Point-to-Point Protocol over Ethernet (PPPoE): If you use a DSL modem and
need a user name and password to connect to the Internet, you may need to
configure your network to use PPPoE.
Make sure you have the information from your ISP available as you configure your
network (see page 63).
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To set up Network preferences for the built-in Ethernet port:
1 Choose Apple (K) > System Preferences from the menu bar.
2 Click Network.
3 Choose Network Port Configurations from the Show pop-up menu.
4 Select the On checkbox next to Built-in Ethernet.

5 Drag Built-in Ethernet to the top of the Port Configurations list to make it the preferred,
or primary, network interface.
Next, follow the instructions to configure your network manually, using DHCP, or using
PPPoE, as instructed by your ISP or network administrator.
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Manual Configuration
Have your static IP address, router address, and subnet mask from your ISP ready
(see page 63).
To set up a manual configuration:
1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.
2 Click TCP/IP, if necessary.
3 In the Configure IPv4 pop-up menu, choose Manually.

4 Type the other information into the corresponding fields.
5 Click Apply Now.
Once you configure your network, your connection is ready. Open your web browser
(or another TCP/IP application) to test your Internet connection.

70

Appendix C Connecting to the Internet

LL2522.book Page 71 Wednesday, February 18, 2004 11:53 AM

DHCP Configuration
After you set up a DHCP configuration, the DHCP server automatically provides your
network information.
To set up a DHCP configuration:
1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.
2 Click TCP/IP, if necessary.
3 Choose Using DHCP from the Configure IPv4 pop-up menu.

4 Click Apply Now.
Open your web browser (or another TCP/IP application) to test your Internet
connection.
Note: Unless your ISP instructs you to do otherwise, ignore the DHCP Client ID field
and the Search Domains field.
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PPPoE Configuration
Some DSL-based ISPs use Point-to-Point Protocol over Ethernet (PPPoE). If you use a
DSL modem and need a user name and password to connect to the Internet, check
with your ISP to determine if you should connect using PPPoE.
To set up a PPPoE connection:
Have your user name, password, and if required, the domain name server (DNS)
address from your ISP available as you configure your network (see page 63).
1 In Network preferences, choose Built-in Ethernet from the Show pop-up menu.
2 Click PPPoE and select “Connect using PPPoE.”

3 Type the information into the corresponding fields. If you want all users of your
computer to use the same connection method, select “Save password.”
Note: To connect automatically when you start a TCP/IP application, such as a web
browser or email, click PPPoE Options, then select “Connect automatically when
needed.”
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4 Click TCP/IP and choose either Using PPP or Manually from the Configure IPv4 pop-up
menu, as instructed by your ISP. If you have a static IP address from your ISP, choose
Manually and type the address in the IP Address field.
5 Type the domain name server (DNS) addresses in the DNS Servers field.

6 Click Apply Now.
Once you configure your network, your Internet connection is ready. You can open your
web browser or other TCP/IP application to test your connection.
Important: If you did not select the option to connect automatically, you will need to
open the Internet Connect application, choose the correct configuration, and then click
Connect. For more information, choose Help > Internet Connect Help from the menu
bar at the top of the display.
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AirPort Extreme Wireless Connection
If your iMac has an AirPort Extreme Card installed, you can configure your AirPort
Extreme network and Internet connection using AirPort Setup Assistant, located in the
Utilities folder within your Applications folder. The assistant helps you configure the
AirPort Extreme Base Station and set up your computer to use AirPort Extreme. For
more information about your AirPort Extreme Base Station, see the AirPort Extreme Base
Station Setup Guide that came with your base station. For information on installing an
AirPort Extreme Card, see “Installing an AirPort Extreme Card” on page 41.
If your AirPort Extreme Base Station is already configured, in most cases your AirPort
Extreme Card is ready to access it immediately.
m

To check if you have access to an AirPort Extreme network:
Click the AirPort status icon in the menu bar and choose an AirPort network listed
there.

If you don’t see an AirPort network listed, you can use AirPort Setup Assistant to check
or change your settings, or you can change them using the Network pane of System
Preferences.

Setting Up an AirPort Extreme Connection Manually
Gather the following information from your system administrator if you’ll be setting up
a manual connection, which uses specific preassigned addresses for your servers and
computer.
If you’ll be connecting using DHCP, most of this information is provided to your
computer automatically by the network, so ask your system administrator what is
required.
• Domain name server (DNS) addresses, if necessary
• DHCP or manual IP address configuration
• IP address
• Router address
• Subnet mask
• Password, if required
Next, make sure your AirPort connection options are active in Network preferences.
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To set up Network preferences for an AirPort Extreme connection:
1 Choose Apple (K) > System Preferences from the menu bar.
2 Click Network.
3 Choose Network Port Configurations from the Show pop-up menu.
4 Select the On checkbox next to AirPort.

Next, follow the instructions to configure your network either manually or using DHCP,
as instructed by your ISP or network administrator. If you’re setting up your network
yourself, it may be easier to configure the network using DHCP, because the server
assigns IP addresses automatically.
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5 Choose AirPort from the Show pop-up menu.
6 Click TCP/IP, if necessary.
7 In the Configure IPv4 pop-up menu, choose either Manually or Using DHCP.

• If you chose Manually, type the other information into the corresponding fields.
• If you chose Using DHCP, you don’t need to enter any further information unless your

system administrator has instructed you to do so.
8 Click AirPort and select options for joining an AirPort Extreme network after restarting
or when your computer wakes from sleep.
9 Click Apply Now.
Once you configure your AirPort settings, you are ready to connect.
m

To test your AirPort Extreme connection:
Click the AirPort status icon in the menu bar and choose Turn AirPort On.
Any AirPort Extreme network in range should appear in the menu.
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Troubleshooting Your Connection
Cable Modem, DSL, and LAN Internet Connections
If you can’t connect to the Internet using your cable modem, DSL, or local area network
(LAN), see the following steps.
Important: Instructions that refer to modems do not apply to LAN users. LAN users
may have hubs, switches, routers, or connection pods that cable and DSL modem users
do not. LAN users should contact their network administrator rather than an ISP.
Check the cables and power supplies
Make sure all modem cables are firmly plugged in, including the modem power cord,
the cable from the modem to the computer, and the cable from the modem to the wall
jack. Check the cables and power supplies to Ethernet hubs and routers.
Turn the modem on and off and reset the modem hardware
Turn off your DSL or cable modem for a few minutes, then turn it back on. Some ISPs
recommend that you unplug the modem’s power cord. If your modem has a reset
button, you can press it either before or after you turn the power off and on.

PPPoE Connections
If you are unable to connect to your Internet service provider using PPPoE, first check
the cables and power supplies, then turn the power off and on and reset the modem
hardware.
Check System Preferences settings:
1 Choose Apple (K) > System Preferences.
2 Click Network.
3 Choose Network Port Configurations from the Show pop-up menu.
4 Drag Built-in Ethernet to the top of the Port Configurations list.
5 Choose Built-in Ethernet from the Show pop-up menu.
6 Click PPPoE.
7 Select “Connect using PPPoE.”
8 Check the Account Name field to be sure you have entered the correct information
from your ISP.
9 Retype your password if you chose to save your password, to be sure it is correct.
10 Click TCP/IP. Make sure you’ve entered the correct information from your ISP
in this pane.
11 Click Apply Now.
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Network Connections
If you have two or more computers attempting to share an Internet connection, be
sure that your network is set up properly. You need to know if your ISP provides only
one IP address or if it provides multiple IP addresses, one for each computer.
If only one IP address is used, then you must have a router capable of sharing the
connection, also known as network address translation (NAT) or “IP masquerading.” For
setup information, check the documentation provided with your router or ask the
person who set up your network. The AirPort Extreme Base Station may be used to
share one IP address among multiple computers. For information on using the AirPort
Extreme Base Station, check the onscreen help or visit the Apple AirPort website at
www.apple.com/airport.
If you cannot resolve the issue using these steps, contact your ISP.
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Communications Regulation Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules.
Operation is subject to the following two
conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation. See instructions if
interference to radio or television reception is
suspected.
Radio and Television Interference
This computer equipment generates, uses, and can
radiate radio-frequency energy. If it is not installed
and used properly—that is, in strict accordance with
Apple’s instructions—it may cause interference with
radio and television reception.
This equipment has been tested and found to
comply with the limits for a Class B digital device in
accordance with the specifications in Part 15 of FCC
rules. These specifications are designed to provide
reasonable protection against such interference in a
residential installation. However, there is no
guarantee that interference will not occur in a
particular installation.
You can determine whether your computer system is
causing interference by turning it off. If the
interference stops, it was probably caused by the
computer or one of the peripheral devices.
If your computer system does cause interference to
radio or television reception, try to correct the
interference by using one or more of the following
measures:
• Turn the television or radio antenna until the
interference stops.
• Move the computer to one side or the other of the
television or radio.
• Move the computer farther away from the
television or radio.
• Plug the computer into an outlet that is on a
different circuit from the television or radio. (That
is, make certain the computer and the television or
radio are on circuits controlled by different circuit
breakers or fuses.)

Changes or modifications to this product not
authorized by Apple Computer, Inc., could void the
EMC compliance and negate your authority to
operate the product.
This product was tested for EMC compliance under
conditions that included the use of Apple peripheral
devices and Apple shielded cables and connectors
between system components. It is important that
you use Apple peripheral devices and shielded
cables and connectors between system components
to reduce the possibility of causing interference to
radios, television sets, and other electronic devices.
You can obtain Apple peripheral devices and the
proper shielded cables and connectors through an
Apple-authorized dealer. For non-Apple peripheral
devices, contact the manufacturer or dealer for
assistance.
Responsible party (contact for FCC matters only):
Apple Computer, Inc. Product Compliance
1 Infinite Loop M/S 26-A
Cupertino, CA 95014-2084
408-974-2000

Industry Canada Statement
Complies with the Canadian ICES-003 Class B
specifications. Cet appareil numérique de la classe B
est conforme à la norme NMB-003 du Canada. Cet
appareil numérique de la classe B est conforme à la
norme NMB-003 du Canada.

VCCI Class B Statement

European Community
Complies with European Directives 72/23/EEC and
89/336/EEC.

If necessary, consult an Apple-authorized service
provider or Apple. See the service and support
information that came with your Apple product. Or,
consult an experienced radio/television technician
for additional suggestions.
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Laser Information

Korea Statement

Warning: Making adjustments or performing
procedures other than those specified in your
equipment’s manual may result in hazardous
radiation exposure.
Do not attempt to disassemble the cabinet
containing the laser. The laser beam used in this
product is harmful to the eyes. The use of optical
instruments, such as magnifying lenses, with this
product increases the potential hazard to your eyes.
For your safety, have this equipment serviced only
by an Apple-authorized service provider.
If you have an internal Apple CD-ROM, DVD-ROM, or
DVD-RAM drive in your computer, your computer is
a Class 1 laser product. The Class 1 label, located in a
user-accessible area, indicates that the drive meets
minimum safety requirements. A service warning
label is located in a service-accessible area. The
labels on your product may differ slightly from the
ones shown here.

High-Risk Activities Warning
This computer system is not intended for use in the
operation of nuclear facilities, aircraft navigation or
communications systems, or air traffic control
machines, or for any other uses where the failure of
the computer system could lead to death, personal
injury or severe environmental damage.

ENERGY STAR® Compliance

Class 1 label

Service warning label

Exposure to Radio Frequency Energy
The radiated output power of the optional AirPort
Extreme Card is far below the FCC radio frequency
exposure limits. Nevertheless, it is advised to use the
wireless equipment in such a manner that the
potential for human contact during normal
operation is minimized.

Mouse Class 1 LED Information
The Apple optical mouse is a Class 1 LED product in
accordance with IEC 60825-1 A1 A2. This product
complies with the requirements of European
Directives 72/23/EEC and 89/336/EEC.
It also complies with the Canadian ICES-003 Class B
Specification.

Taiwan Statement
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As an ENERGY STAR® partner, Apple has determined
that standard configurations of this product meet
the ENERGY STAR® guidelines for energy efficiency.
The ENERGY STAR® program is a partnership with
office product equipment manufacturers to promote
energy-efficiency. Reducing energy consumption of
office products saves money and reduces pollution
by eliminating wasted energy.

Battery Disposal Information
Dispose of batteries according to your local
environmental laws and guidelines.
Nederlands
Gebruikte batterijen kunnen worden ingeleverd bij
de chemokar of in een speciale batterijcontainer
voor klein chemisch afval (kca) worden
gedeponeerd.

Telephone and Apple 56K Modem
Information
Notify Your Telephone Company
Some telephone companies require that you notify
the local business office when you hook up a
modem to their lines.
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Information You Need in the United States
The internal modem complies with Part 68 of the
FCC rules. On the back of this equipment is a label
that contains, among other information, the FCC
registration number and ringer equivalence number
(REN). If requested, provide this information to your
telephone company.
• Ringer equivalence number (REN): 0.1B The REN is
useful to determine the quantity of devices you
may connect to your telephone lines and still have
all those devices ring when your telephone
number is called. In most, but not all areas, the
sum of the RENs of all devices connected to one
line should not exceed five (5.0). To be certain of
the number of devices you may connect to your
line, as determined by the REN, you should contact
your local telephone company to determine the
maximum REN for your calling area.
• Telephone jack type: USOC, RJ-11 An FCC-compliant
telephone cord and modular plug are provided
with this equipment. This equipment is designed
to be connected to the telephone network or
premises wiring using a compatible modular jack
that complies with Part 68 rules. See the
installation instructions for details.
Telephone Line Problems
If your telephone doesn’t work, there may be a
problem with your telephone line. Disconnect the
modem to see if the problem goes away. If it doesn’t,
report the problem either to your local telephone
company or to your company’s telecommunications
people.
If disconnecting the modem eliminates the problem,
the modem itself may need service. See the service
and support information that came with your Apple
product for instructions on how to contact Apple or
an Apple-authorized service provider for assistance.
If you do not disconnect your modem when it is
adversely affecting the telephone line, the telephone
company has the right to disconnect your service
temporarily until you correct the problem. The
telephone company will notify you as soon as
possible. Also, you will be informed of your right to
file a complaint with the FCC.
The telephone company may make changes in its
facilities, equipment, operations, or procedures that
could affect the operation of your equipment. If this
happens, the telephone company will provide
advance notice in order for you to make the
necessary modifications to maintain uninterrupted
service.

The internal modem will not work with party lines,
cannot be connected to a coin-operated telephone,
and may not work with a private branch exchange
(PBX).
Telephone Consumer Protection Act
The Telephone Consumer Protection Act of 1991
makes it unlawful for any person to use a computer
or other electronic device to send any message via a
telephone fax machine unless such message clearly
contains, in a margin at the top or bottom of each
transmitted page or on the first page of the
transmission, the date and time it was sent and an
identification of the business or other entity, or
individual sending the message and the telephone
number of the sending machine of such business,
entity, or individual.
Information You Need in Canada
The Industry Canada (IC) label identifies certified
equipment. This certification means that the
equipment meets certain telecommunications
network protective, operational, and safety
requirements. The Department does not guarantee
the equipment will operate to a user’s satisfaction.
Before installing this equipment, make sure that you
are permitted to connect to the facilities of the local
telecommunications company. Be sure you use an
acceptable method of connection to install the
equipment. In some cases, you may extend the
company’s internal wiring for single-line individual
service by means of a certified telephone extension
cord. Be aware, however, that compliance with these
conditions may not prevent degradation of service
in some situations.
Repairs to certified equipment should be made by
an authorized Canadian maintenance facility
designated by the supplier. Any equipment
malfunctions or repairs or alterations that you make
to this equipment may cause the
telecommunications company to request that you
disconnect the equipment.
In Canada, contact Apple at: 7495 Birchmount Road,
Markham, Ontario, L3R 5G2, 800-263-3394
Warning: Users should ensure for their own
protection that the electrical ground connections
of the power utility, telephone lines, and internal
metallic water pipe system, if present, are
connected together. This precaution may be
particularly important in rural areas.
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Users should not attempt to make such connections
themselves, but should contact the appropriate
electric inspection authority or electrician.
• Load number: 0.1 The load number (LN) assigned
to each terminal device denotes the percentage of
the total load to be connected to the telephone
loop that is used by the device, to prevent
overloading. The termination of a loop may consist
of any combination of devices, subject only to the
requirement that the sum of the load numbers of
all devices does not exceed 100.
• Telephone jack type: CA-11
Informations Destinées aux Utilisateurs Canadiens
L’étiquette d’Industrie Canada identifie un matériel
homologué. Cette étiquette certifie que le matériel
est conforme à certaines normes de protection,
d’exploitation et de sécurité des réseaux de
télécommunications. Le Ministère n’assure toutefois
pas que le matériel fonctionnera à la satisfaction de
l’utilisateur.
Avant d’installer ce matériel, l’utilisateur doit
s’assurer qu’il est permis de la raccorder au réseau de
l’enterprise locale de télécommunication. Le matériel
doit également être installé en suivant une méthode
acceptée de raccordement. Dans certains cas, le
câblage appartenant à l’enterprise utilisé pour un
service individuel à ligne unique peut être prolongé
au moyen d’un dispositif homologué de
raccordement (cordon prolongateur téléphonique).
L’abonné ne doit pas oublier qu’il est possible que la
conformité aux conditions énoncées ci-dessus
n’empêche pas la dégradation du service dans
certaines situations. De fait, les enterprises de
télécommunication ne permettent pas que l’on
raccorde un matériel aux prises d’abonnés, sauf dans
les cas précis prévus par les terifs particuliers de ces
enterprises.
Les réparations de matériel homologué doivent être
effectuées par un centre d’entretien canadien
autorisé désigné par la fournisseur. La compagnie de
télécommunications peut demander à l’utilisateur de
débrancher un appareil suite à des réparations ou à
des modifications effectuées par l’utilisateur ou en
raison d’un mauvais fonctionnement.
Veuillez contacter Apple pour des informations
supplémentaires :
Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
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Service à la clientèle d’Apple Canada : 800-263-3394
Avertissement : Pour sa propre protection,
l’utilisateur doit s’assurer que tout les fils de mise à
la terre du secteur, des lignes téléphoniques et les
canalisations d’eau métalliques, s’il y en a, soient
raccordés ensemble. Cette précaution est
particulièrement importante dans les régions
rurales.
L’utilisateur ne doit pas tenter de faire ces
raccordements lui-même; il doit avoir recours à une
service d’inspection des installations électriques ou à
un électricien, selon le cas.
• Numéro de charge : 0.1 L’indice de charge (IC)
assigné à chaque dispositif terminal indique, pour
éviter toute surcharge, le pourcentage de la
charge totale qui sera raccordée à un circuit
téléphonique bouclé utilisé par ce dispositif. La
terminaison du circuit bouclé peut être constituée
de n’importe quelle combinaison de dispositifs
pourvu que la somme des indices de charge de
l’ensemble des dispositifs ne dépasse pas 100.
• Type de prise téléphonique : CA-11
Information You Need in the United Kingdom
This terminal equipment is intended for direct
connection to the analogue Public Switched
Telecommunications Network and is approved for
use within the United Kingdom with the following
features:
• Modem facility
• Autocalling facility
• Autoanswer facility
• DTMF signaling
Operation in the absence of proceed indication or
upon detection of proceed indication
This product is in conformity with relevant
regulatory standards following the provisions of
European Council Directives 73/23/EEC (Low Voltage
Directive) and 89/336/EEC amended by 92/31/EEC
(EMC Directive).
Informationen fur Deutschland
Diese Modem-Karte ist als Endeinrichtung
vorgesehen und muss an ein TAE mit F-Kodierung
angeschlossen werden. Diese Endeinrichtung ist in
Konformität gemäss Niederspannungsrichtlinie 73 /
23 / EWG sowie EMC-Richtlinien 89 / 336 / EWG und
92 / 31 / EWG.
Informations pour la France
Ce matériel est conforme aux normes applicables de
sécurité éléctrique d’après la directive 73 / 23 / CEE
et aux normes applicables de comptabilité
éléctromagnétique d’après la directive 89 / 336 /
CEE, modifié par la directive 92 / 31 / CEE.
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Information You Need in Australia
All telecommunications devices are required to be
labelled as complying to the Australian
telecommunications standards, ensuring the health
and safety of the operator and the integrity of the
Australian telecommunications network. To provide
compliance with the Australian Communications
Authority’s technical standards, please ensure that
the following AT commands are maintained:
• ATB0 (ITU/CCITT operation)
• AT&G0 (no guard tone)
• AT&P1 (33/66 pulse dial make/break ratio)
• ATS0 = 0 or ATS0 = 1 (no answer or answer greater
than one ring)
• ATS6 = 95 (DTMF period between 70–255 ms)
• ATS11 = 95 (DTMF period between 70–255 ms)
For calls that are automatically generated, a total of
three call attempts are allowed to a telephone
number, with a minimum period between calls of 2
seconds. If the call does not connect after three
attempts, 30 minutes must expire before automatic
redialing may be initiated. Failure to set the modem
(and any associated communications software) to
the above settings may result in the modem being
non-compliant with Australian telecommunications
standards. Under these circumstances a user could
be subject to significant penalties under the
Telecommunications Act 1997.
This modem must be properly secured in order for
you to use it. Telecommunications network voltages
exist inside the computer and the
telecommunications line connection must be
removed before opening the computer.

Information You Need in New Zealand
This modem is fully approved to operate on the New
Zealand telecommunications network under
Telepermit number PTC 211/04/002. All
telecommunications devices are required to hold a
Telepermit and be labelled accordingly with the
approved Telepermit number to comply with the
New Zealand telecommunications standards,
ensuring the health and safety of the operator and
the integrity of the New Zealand
telecommunications network. To ensure compliance,
all calls that are automatically generated should not
make more than 10 call attempts to the same
number within any 30 minute period with a
minimum period between calls of 30 seconds.
Failure to adhere to these standards may result in
the modem being non-compliant with New Zealand
Telecom standards. Under these circumstances a
user could be subject to significant penalties.
Important: The grant of a Telepermit for any item of
terminal equipment indicates that only Telecom has
accepted that the item complies with minimum
conditions for connection to its network. It indicates
no endorsement of the product by Telecom, nor
does it provide any sort of warranty. Above all, it
provides no assurance that any item will work
correctly in all respects with another item of
Telepermitted equipment of a different make or
model, nor does it imply that any product is
compatible with all of Telecom’s network services.
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AirPort Extreme 13, 28
connection 65
installing an AirPort Extreme Card 41
problems using 52
setting up 74
application freeze 21
applications
reinstalling applications 51
audio line in port 15
audio line out port 15

date and time settings lost 53
DHCP 65
configuration 71
dial-up
connection 66
modem 65
dialup connection 61
digital video camera 26
display
adjusting 8
cleaning 57
downloading software 19
DSL 65, 68
DVD
burning (recording) 35
DVD-ROM/CD-RW Combo drive 13, 32
DVD-Video, playing 34
Dynamic Host Configuration Protocol (DHCP) 68

B
battery
replacing the internal backup battery 44
burning a CD-R or CD-RW disc 34
burning a DVD 35

C
cable modem 68
cameras
digital 24
DV 26
carrying your eMac 58
CD
burning (recording) 34
CD-ROM drive 13, 32
changing
System Preferences 17
the desktop 17
cleaning your computer 57
Combo drive 13, 32
connecting
a printer 18
headphones 19
to a network 29
to an external display or VGA projector 30
to a TV, video projector, or VCR 30

E
ejecting a disc 52
eject key 13
eMac
front view 12
side view 14
environment 59
ergonomics 60
Ethernet 29
port 15
external hard disks 26

F
FireWire
connecting devices 26
ports 15
FireWire Target Disk Mode 27
floppy disk drives 24
Force Quit 21
freezing up 50
frozen application 21

85

LL2522.book Page 86 Wednesday, February 18, 2004 11:53 AM

G

O

game pads 24

optical disc drive 13, 32

H

P

hard disks 26
headphone/audio line out port 15

Point-to-Point Protocol 65, 68, 72
power button 15
power indicator light 13
power socket 15
PPPoE 65
configuration 72
Print & Fax preferences 18
printing 18
setup 18
problems
AirPort Extreme 52
computer freezes during startup 50
computer won’t respond 50
computer won’t start up 50
connecting to Internet 77
date and time settings lost 53
ejecting a disc 52
Internet connection 52
problem with an application 52

I
iDVD 35
inserting a CD or DVD 33
Internet
configuration 67
connecting to 8, 74
problems connecting 52, 77
settings 63
Internet service provider 61
iPod 26
ISP 61

J
joysticks 24

K
keyboard 7, 24
controls 35
ergonomics 60

R

L

S

LAN 68
connection 65

safety 58
scanners 24, 26
security slot 15
securing your computer 36
serial number 54
setting up a printer 18
setting up your computer 6
shutting down 9
sleep 9
Software Update 19
speakers 13
specifications 55
static IP address 70
stopping
an application 21
SuperDrive 13, 32
System Preferences 17
System Profiler 55

M
Mac Help 22
Mac OS 9 16
Mac OS X 16
reinstalling 51
manual Internet configuration 70
memory 15
installing additional memory 37
seeing how much memory your computer has 40
microphone 13
modem
cable 29, 61
DSL 29, 61
port 15
monitoring
a printer 18
mouse 7, 13
ergonomics 60

N
network connections 78
Network Setup Assistant 61
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testing your Internet configuration 67
transferring
files or documents 20
troubleshooting 49

LL2522.book Page 87 Wednesday, February 18, 2004 11:53 AM

U

V

updating software 19
USB 7, 24
connecting devices 24
hubs 25
ports 13, 15
using multiple devices at once 25

video out port 15, 30
volume controls 13

Index

W
wireless networking and Internet
installing an AirPort Extreme Card 41
wireless networking and Internet access 28
working with a printer 18
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